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Was ist SimPe?

SimPe (Simple Package Editor) ist ein Programm zum Bearbeiten von gepackten Dateien innerhalb von
Sims2-Package-Dateien. Man kann damit bisher eine Reihe von Dateitypen bearbeiten. So lassen sich zum Beispiel
Eigenschaften von Sims(Alter, Karriere, Laufbahn, Schulnoten, Geschlecht usw.) verändern, Familien bearbeiten(Vermögen und
Mitglieder), Beziehungen zwischen den Sims verändern, alle möglichen Texte (Namen und Beschreibungen von Sims, Familien,
Nachbarschaften und Lots) bearbeiten und und und. Auch viele der im Umlauf befindlichen gehackten und recolorierten Objekte
wurden mit Hilfe von SimPe erstellt.
An dieser Stelle möchte ich meinen besonderen Dank an Quaxi, den Entwickler von SimPe, senden: Du leistest wirklich
großartige Arbeit!

Installation

Die jeweils aktuelle Version von SimPe könnt Ihr euch von Quaxi's Seite (http://sims.ambertation.de ) herunterladen. Ihr müsst nur
das Installationsprogramm starten und den Anweisungen folgen. Um SimPe ausführen zu können, benötigt Ihr außerdem
zwingend noch das Microsoft .NET Framework, welches Ihr auf dieser Seite
http://www.microsoft.com/downloads/details.aspx?displaylang=de&FamilyID=262d25e3-f589-4842-8157-034d1e7cf3a3

herunterladen könnt, falls es nicht schon installiert ist.

Sicherheit

SimPe selber besitzt zwei Backup-Möglichkeiten, die ich noch erläutern werde (siehe Konfiguration und Nachbarschaft
auswählen). Es kann trotzdem nicht schaden, in regelmäßigen Abständen eine Kopie des kompletten Die Sims 2-Ordners unter
Eigene Dateien zu machen. Im Übrigen kann das auch ein Schutz gegen eventuelle Schädigungen durch Hack-Objekte oder
dergleichen sein. Die Kopie Eurer Spieldaten erzeugt Ihr Euch am einfachsten dadurch, dass Ihr im Explorer mit rechter
Maustaste auf das Verzeichnis Die Sims 2 unter Eigene Dateien\EA Games klickt und Kopieren wählt. Dann geht Ihr in das
Verzeichnis in dem Ihr die Sicherungskopie haben möchtet und sagt, wieder über rechte Maustaste, Einfügen.



Konfiguration

SimPe ist schnell konfiguriert. Im Menü Extras werden die nötigen Einstellungen vorgenommen:

Wenn HexView aktiviert angehakt ist, so wird der Inhalt einer gewählten Datei auf dem Reiter Entpackte Daten dargestellt.
Meine Empfehlung: Dieses Häkchen setzen.
Die Option keine Meta Informationen laden bewirkt, dass für Sims keine Namen und Bilder angezeigt werden. Für die
Nutzung vieler Funktionen, die im Folgenden beschrieben sind, ist es erforderlich, dass diese Option nicht gewählt ist! Eine
Änderung wird erst nach dem erneuten Laden einer Nachbarschaft wirksam!
Dateiname extrahieren  bewirkt, dass für einige Dateitypen in der Dateiliste neben dem Typ auch der Name der Datei
erscheint. Meine Empfehlung: Dieses Häkchen setzen.

Durch Auswahl von Extras->Optionen… wird folgendes Fenster geöffnet:

Sims 2 Verzeichnis: Verzeichnis, dass bei der Installation von Sims 2 gewählt wurde. SimPe benötigt es für die Funktion
Tools->Sims 2 ausführen mit der Ihr aus SimPe das Spiel starten könnt.
Benutzerdaten: Pfad zum Verzeichnis, indem Euer Spielstand gespeichert ist.
Nvidia DDS Tool Folder: Hier könnt Ihr den Pfad zum Nvidia DDS Tool (sofern vorhanden) hinterlegen. Dies ist vor allem für
das Recolorieren interessant, da sich so aus SimPe auch DDS-Texturen erzeugen lassen. Die Angabe ist Optional!
Externe Tools: Neben dem Pfad zur exe-Datei eines Hex-Editors, der dann mit der Drucktaste mit HexEditor öffnen auf dem
Reiter Eingebettete Datei gestartet werden kann, um den Inhalt der gewählten Datei mit diesem zu bearbeiten, lassen sich hier
auch für unterschiedliche Dateitypen unterschiedliche Programme zur Bearbeitung hinterlegen. Sie lassen sich dann für die
extrahierten Datein aus SimPe heraus starten. Die Angaben sind optional.
Standard Sprache: Sprache in der in SimPe Namen von Sims angezeigt werden.
Die Option Spiel im Debug Modus starten bewirkt, dass der Cheat "boolProp testingCheatsEnabled true" dauerhaft im Spiel
aktiviert ist. SimPe schreibt dazu den Cheat in die Datei userStartup.cheat im Verzeichnis \Eigene Dateien\EA Games\Die
Sims 2\Config\, die bei jedem Spielstart gelesen wird.
Wenn nackte Sims zensieren nicht gewählt ist wird der "Nackt"-Cheat "intprop censorgridsize 0" in die userStartup.cheat
geschrieben und somit die Verpixelung ausgeschaltet.
Auto Backup bewirkt, dass beim Speichern einer Package-Datei von SimPe automatisch eine Sicherungskopie des alten
Standes mit der Dateierweiterung bak  erzeugt wird. Somit lassen sich Änderungen mit wenig Aufwand wieder rückgängig
machen.
Spiel mit Ton starten bewirkt, dass das Spiel beim Start mit Tools->Sims 2 ausführen mit Ton ausgeführt wird.
Standardmäßig ist der Ton ausgeschaltet (Quaxi hat wohl dünne Wände und testet nur nachts!).
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Nachbarschaft öffnen

Über das Menü Plugins->Nachbarschaft auswählen…

wird das Fenster Nachbarschaft auswählen geöffnet:

Hier stehen Euch folgende Möglichkeiten nach Auswahl einer Nachbarschaft durch Klick zur Verfügung:
Öffnen öffnet die gewählte Nachbarschaftsdatei.
Mit Backup erstellen wird eine Sicherungskopie der kompletten Nachbarschaft im Verzeichnis \Eigene Dateien\EA
Games\SimPE Backup\ erstellt.
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Wählt Ihr Backup Verwalten… wird dieses Fenster geöffnet:

Nach Auswahl des Backups könnt Ihr hier Eure Nachbarschaft wiederherstellen oder das gewählte Backup löschen. Für beide
Funktionen muss jeweils eine Sicherheitsabfrage bestätigt werden.
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Sim bearbeiten

Wenn Ihr eine Nachbarschaft geöffnet habt, könnt Ihr mit dem Menü Plugins->Sim auswählen… 

das Fenster zur Auswahl von Sims aufrufen:

Hier werden Euch alle Sims der gewählten Nachbarschaft mit Bild und Namen angezeigt. Die geschwärzt dargestellten Sims,
die mit einem blauen Quadrat gekennzeichnet sind, sind in keiner Familie enthalten und auch keine NPC's. Sind Sims
zusätzlich mit dem roten Quadrat gekennzeichnet, so sind es "Pseudo"-Sims, die vom Spiel nur für die Stammbäume und
Erinnerungen generiert werden. Solche Sims lassen sich nicht "beleben", sie sind nicht spielbar.
Mit Öffnen gelangt Ihr auf die Plugin Ansicht für den gewählten Sim, wo Ihr ihn bearbeiten könnt:
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Hier habt Ihr eine Fülle von Möglichkeiten, Eigenschaften Eurer Sims zu verändern.

Generell gilt: Wenn Ihr Änderungen vorgenommen habt müsst Ihr Übernehmen drücken und am Ende bzw. bevor Ihr eine
andere Nachbarschaft oder Package-Datei öffnet Datei->Speichern wählen.
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Jetzt möchte ich Euch die Bearbeitungsmöglichkeiten, die Ihr auf der Plugin Ansicht "Sim Beschreibung" habt, erläutern. 

Im oberen Bildbereich

findet Ihr folgende Felder:
SimID: Eindeutige Nummer Eures Sims, die für spätere Bearbeitungsmöglichkeiten wichtig sein kann.
Name: Vor- und Nachname des Sim.
Family Number: Nummer der Famile in der Nachbarschaft, der der Sim angehört.
Lebensabschnitt: Hier könnt Ihr die Altersstufe Eures Sims festlegen. Das Ändern bewirkt allerdings nur eine
Verhaltensänderung, keine Änderung des Aussehens!
Sternzeichen: Eine Änderung des Sternzeichens hat keine Auswirkung auf den Character des Sim.
Verbleibende Tage: Anzahl der Tage, bis zum Wechsel in die nächste Altersstufe. Im Spiel wird immer ein Tag mehr
angezeigt, als hier, da ja dort auch am Geburtstag noch 1 Tag bis zum Älterwerden verzeichnet wird. 
Laufbahn: Hier könnt Ihr die Laufbahn Eures Sim ändern.
Mit behandeln als Frau oder Mann legt Ihr das Geschlecht des Sim fest. Dies hat keine Auswirkung auf das Aussehen des
Sim, nur auf sein Verhalten und die Möglichkeiten, die im Spiel zur Verfügung stehen.

Auf der Plugin Ansicht findet Ihr fünf Karteireiter. Der Reiter Interessen

bietet die Möglichkeit, Interessen Eurer Sims für den Kontakt mit anderen zu bearbeiten. Ihr klickt dazu entweder auf die Balken
oder ändert die Zahlenwerte. Man kann über Frauen/Männer abstoßend/anziehend auch die Präferenz des Sim festlegen
und somit bestimmen, ob er homo- oder heterosexuelle (oder gar keine?) Kontakte bevorzugt. Durch Klicken auf max werden
sämtliche Werte auf diesem Reiter maximiert.
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Auf dem zweiten Reiter Beziehungen könnt Ihr die Beziehungen Eures Sims zu anderen bearbeiten:

In der Mitte sind alle Sims gelistet, die der dargestellte Sim kennt. Wenn Ihr aus dieser Liste einen Sim auswählt, habt Ihr die
Möglichkeit die Beziehung zu diesem zu bearbeiten. Dazu stehen zwei Feldgruppen zur Verfügung: Wie sehr dieser Sim den
auf der Liste selektierten mag und Wie sehr der in der Liste markierte diesen Sim mag. Ihr habt jeweils folgende
Möglichkeiten: Tagesanzeige entspricht dem oberen Wert in der Beziehungsleiste im Spiel, Gesamtanzeige dem unteren. Im
Feld darunter könnt Ihr das Verwandtschaftsverhältnis festlegen. Die Ankreuzfelder sind meines Erachtens sprechend
bezeichnet. Wenn Ihr Änderungen vorgenommen habt, müsst Ihr auf Beziehung übernehmen klicken, damit sie wirksam
werden. Beim jeweils anderen Sim braucht Ihr die Änderungen nicht noch mal durchführen, sie werden automatisch
übernommen. Mit entfernen könnt Ihr den in der Liste markierten Sim aus dem Bekanntenkreis löschen. Auch ist es möglich
mit Hilfe des Drop-Down-Feldes einen Sim auszuwählen und mit aufnehmen --> in den Bekanntenkreis zu übernehmen.

Auf dem Reiter Fähigkeiten könnt Ihr die Fähigkeitspunkte Eurer Sims bearbeiten:

Neben den aus dem Spiel bekannten Fähigkeiten, findet Ihr hier auch die unsichtbare Fähigkeit Romance. Ein Fähigkeitspunkt
entspricht jeweils einem Wert von 100. So könnt Ihr auch Bruchteile von Fähigkeitspunkten, entweder durch Klick auf den
Balken, oder durch Eingabe des Wertes festlegen. Klickt Ihr auf max werden alle Fähigkeiten maximiert.
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Auf dem vierten Reiter Character habt Ihr eine Reihe von Möglichkeiten:

Unter Character könnt Ihr die Charakter-Punkte Eures Sim verändern. Welche Charaktereigenschaften sich vererben, wird unter
Genetic Character festgelegt. Beide Feldgruppen bieten die Möglichkeit durch einen Klick auf max alle Punkte auf 10 zu
setzen. Für Kinder und Teenies kann man die Art der Schule (privat oder öffentlich) und die aktuelle Note festlegen. In der
Feldgruppe Stimmung könnt Ihr Laufbahnanzeige und Laufbahnpunkte verändern. Unter Karriere im Feld Pfad kann die
eingeschlagene Karriere festgelegt werden. Im Feld Stufe, die Karrierestufe, wobei für Teenies hier ein Wert größer 3 keinen
Sinn macht und vom Spiel auf 3 zurückgesetzt wird. Je höher die Leistung, desto schneller kommt die Beförderung. Tote Sim
besitzen das Is Ghost Merkmal. Über die anderen Ghost-Kennzeichen, kann festgelegt werden, ob der Sim durch Objekte,
Wände oder Sims hindurch gehen kann (Er muss dazu übrigens nicht unbedingt tot sein!)

Auf dem letzten Reiter Erweitert

könnt Ihr unter Decay die Bedürfnisse des Sim beeinflussen. Bei einem Wert von 0 ist der jeweilige Balken im Spiel total grün.
Im Feld Days in prev. Age stehen die Tage, die der Sim in vorangegangenen Lebensabschnitten verbracht hat. Dies wirkt sich
auf die Altersanzeige bei Knackern aus. Mit dem Feld Age duration kann die Dauer des aktuellen Lebensabschnitts verändert
werden. Unter Bodyshape könnt Ihr festlegen ob Euer Sim dick, fit oder gar schwanger ist. Der erste Schwangerschaftstag
entspricht dabei Pregnant(Invisible), der zweite Pregnant(Half) und der dritte Pregnant(Full).

Übernehmen und Datei->Speichern nicht vergessen!
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Familie bearbeiten

Wenn Ihr eine Nachbarschaft geöffnet habt, wählt Ihr unter Dateitypen Family Information. Unter Eingebettete Dateien findet
Ihr nun alle Familiendateien. Um die gewünschte Familie zu finden, klickt Ihr sie der Reihe nach durch oder Ihr tragt die Family
Number (aus "Sim Beschreibung") im Feld Instanz Filter ein:

Auf der Plugin Ansicht im "FAMi Editor" habt Ihr nun folgende Möglichkeiten:
Im Feld Name könnt Ihr den Familiennamen ändern. 
Über Guthaben lässt sich das Barvermögen der Familie festlegen.
Wenn man die Anzahl der Familien Freunde ändert, so hat das nach meinen Erfahrungen keine Auswirkungen im Spiel. Sie
wird auch vom Spiel wieder auf die richtige Zahl zurückgesetzt.
Unter Familien Mitglieder  habt Ihr die Möglichkeit, Sims aus der Familie zu löschen oder mit Hilfe des Drop-Down-Feldes
weitere Sims in die Familie aufzunehmen. Wenn Ihr Sims aus einer Familie löscht und sie in keine andere steckt, landen sie
nicht in der Familientonne. Neue Familienmitglieder müssen "echte" Sims sein, also solche die bei "Sim auswählen" bunt
erscheinen. Es können jedoch auch NPC's sein. Vergesst dabei nicht sie aus ihren alten Familien zu löschen, um Probleme im
Spiel zu vermeiden!

Nach Änderungen noch Übernehmen und Datei->Speichern!

10



Name einer Nachbarschaft ändern

Nach dem Öffnen einer Nachbarschaft, wählt Ihr unter Dateitypen Catalog Description und unter Eingebettete Dateien die
einzige aus:

Auf dem Reiter Plugin Ansicht wählt Ihr nun bei Sprache Deutsch aus.
Unter Zeichenketten findet Ihr bei 0x0 den Namen und unter 0x1 die Beschreibung Eurer Nachbarschaft. Wählt den Namen
durch Klick aus. Nun könnt Ihr diesen unter Wert  ändern.

Jetzt nur noch Übernehmen und Datei->Speichern!.
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Recolorieren von Objekten

Mit  dem Object Workshop lassen sich nahezu alle Objekte im Spiel mit neuen Farboptionen versehen. Wenn Ihr auch  Objekte
recolorieren wollt, die im Spiel nicht schon standardmäßig Farboptionen haben, braucht Ihr den Color Options Enabler (CEP),
den Ihr auch auf der SimPe Home findet. Die Installationsdatei müsst Ihr einfach ausführen. Auch um die Farboptionen solcher
Objekte zu verwenden wird der CEP benötigt.
Wenn Ihr vom Object Workshop mal ein leeres oder unvollständiges Package erzeugt bekommt, habt Ihr euch leider eins der
wenigen Objekte ausgesucht, deren Bearbeitung mit dem Object Workshop zurzeit nicht möglich ist!

Wählt Plugins->Object Workshop…

Nach einer Weile öffnet sich dieses Fenster:

Alle Objekte werden Euch hier aufgelistet. Solche, die für die ein Vorschaubild existiert, sind mit einem * gekennzeichnet. Sucht
aus der Liste das gewünschte Objekt heraus und klickt es an. Wählt Color Options und die Option Create Color Extension
Package aus und drückt Start
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Vergebt nun einen Namen für Euer neues Package, welches Ihr am besten in ein neues Verzeichnis speichert.
Später darf dieser Name nicht mehr geändert werden!

Wenn es sich um ein mehrteiliges Objekt handelt, bekommt Ihr noch dieses Auswahlfenster:

Hier müsst Ihr jetzt mit Select noch den Teil auswählen, den Ihr bearbeiten wollt.
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SimPe erzeugt nun ein neues Package:

Klickt unter Eingebettete Dateien auf Texture Image und wählt die Plugin Ansicht.
Hier wählt Ihr das größte Bild und drückt Export.
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Übernehmt am besten den vorgeschlagen Namen für die Bilddatei, wählt das gewünschte Format und drückt Speichern.
Die exportierte Textur bearbeitet Ihr nun mit einem Grafikprogramm!
In SimPe wählt Ihr dann Import… 

Wählt die bearbeitete Textur aus und Öffnen.

Jetzt macht Ihr einen Rechtklick auf das Bild und wählt Update all Sizes .
Nun noch Commit drücken und Datei->Speichern.

Die Package-Datei kopiert Ihr in das Downloads-Verzeichnis. Aber auf keinen Fall den Namen ändern! Somit ist eine neue
Farboption des Objekts im Spiel verfügbar.
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Neue Bilder mit dem Photo Studio

Wenn Ihr Farboptionen für die Bilder im Spiel erzeugen möchtet, benutzt Ihr am besten das Photostudio. Auch hierfür wird der
Color Options Enabler (CEP) benötigt! Wenn Ihr ein Bild von einem Sim haben möchtet, müsst Ihr zunächst die Nachbarschaft
öffnen, in der der Sim zu finden ist. Soll es ein eigenes Bild sein, könnt Ihr sofort Plugins->Photo Studio… wählen.

Über Open… wählt Ihr nun euer Bild, das als Farboption im Spiel erscheinen soll, oder Ihr wählt auf dem Reiter Sims den Sim
für das Bild aus

Unter Picture Base sucht Ihr Euch eine Vorlage (für dieses Bild wird die Farboption dann im Spiel verfügbar). Achtet dabei vor
allem auf die Größenverhältnisse, um Verzerrungen zu vermeiden. Ein Klick auf create, dann Package-Namen vergeben (diesen
später nicht ändern!) und schon seid Ihr fertig!
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Sims Surgery Tool

Das Surgery Tool bietet die Möglichkeit, das Aussehen vorhandener Sims nachträglich zu verändern. Dazu benötigt Ihr
allerdings in der gleichen Nachbarschaft einen Sim mit dem gewünschten Aussehen. Auch können Sims, die Ihr im Spiel
erstellt habt, exportiert werden, um sie im Bodyshop und im Spiel als Vorlage zur Verfügung zu haben oder sie zu verschicken. 
Zunächst öffnet Ihr die Nachbarschaft und wählt dann im Menü Plugin->Sims Surgery…

Das Sims Surgery Tool öffnet sich:

Unter Sim Pool werden die Sims der Nachbarschaft mit Bild und Namen angezeigt.
Export eines Cas-Sims:
Wenn ihr einen Sim exportieren wollt, wählt Ihr ihn hier aus und klickt auf use unter Patient Sim. Jetzt auf Export klicken und
am besten im SavedSims-Verzeichnis abspeichern. Wenn Ihr nun den Bodyshop startet, habt Ihr dort nun für diesen die
gleichen Möglichkeiten, wie für die anderen Sims. Sobald Ihr ihn einmal im Bodyshop gesehen habt, steht er auch als Vorlage
im Spiel zur Verfügung.
Aussehen verändern:
Wenn Ihr das Aussehen eines Sims verändern wollt, wählt den zu verändernden Sim aus und klickt auf use unter Patient Sim.
Nun wählt Ihr den Vorlage-Sim und klickt auf use unter Archetype Sim.
Die Option only Face bewirkt, dass nur das Gesicht des Sims kopiert wird.
Mit Only Skintone wird nur die Hautfarbe geändert.
Wählt Ihr keine dieser Optionen wird der komplette Vorlage-Sim (incl. Klamotten) kopiert.
Dazu einfach Surgery wählen.

Fortsetzung folgt
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